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What is podcasting? 
 

Welcome to the wonderful world of podcasting! 
 

But what is podcasting?  
 

Podcasts are a form of digital audio content made available on the internet for streaming or 

downloading to a digital device. Podcasting is a different mode of broadcasting compared to 

traditional radio, allowing listeners to choose the time and place of their listening.  

 

Podcasts can be found in a variety of online spaces but are typically distributed on podcast 

apps: 

• In a complete package, as a podcast series with a limited number of episodes, 

• or as a regular, ongoing show (e.g., weekly, or monthly), with new episodes 

automatically received by subscribers through their apps.  

• A “podcast” can also refer to a single audio file, or episode in a podcast series or show.   

 

Video podcasts—not covered in this course—are a new podcast form increasing visual engagement, 

but much more expensive and time consuming to produce, and less convenient for listeners. 
 

 
 

Podcasts are produced by traditional radio stations ⁠, such as 3CR Community Radio ⁠, or by 

independent producers. Previously known as audio-blogs back in the 1980’s, this versatile DIY 

media form gained traction in the mid-late 2000s.  These days the popularity of podcasts is 

widespread, and pretty much anyone can make a podcast—when you know how.  
 

This handbook is a support resource for 3CR’s Podcast Training Course, which is the perfect 

place for new podcasters to begin—whether you're an individual, an organisation or a 

community group. For podcasters looking for a professional-sounding podcast, 3CR also offers 

Podcast Production Support. To find out more about 3CR's Podcasting Services contact the 

station at projects@3cr.org.au, or call us on 03 9419 8377. 

 

mailto:projects@3cr.org.au
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Planning 

Defining Your Concept and Audience:  

Start by clearly defining your podcast's concept and target audience. What is the central 

theme or topic of your series, and who are you creating it for? Understanding this is crucial to 

maintaining consistency. 

What is my idea? 

Focusing on a clear central idea is essential for planning your podcast—whether it’s a single 

episode, limited series, or an ongoing show.  

 

The core idea is the fundamental reason why any podcast exists. Each episode of a podcast has 

an implicit promise contained within it that the creator is going to explore whatever ideas are 

at the core of the show, to some degree. 

 

When planning the concept for your podcast, you should also consider: 

 
- Are there already podcasts covering your concept? What will be your point of difference?  

- Are you targeting a specific niche? How will you play to your audience? 

- Who will present the podcast?  

- Identify potential guests (if you are having guests). 

- Do you want to engage with your guest, or will they narrate the story themselves? 

- Podcast design structure: Building your content around a consistent structure helps listeners 

know what to expect and keeps them engaged. 

- Length of podcast: The versatile podcast format ensures that episodes can be any length that 

suits your project. They don’t have all be the same length. However, some data shows that the 

longer the podcast, the less likely the listeners are to hear out the entire audio.   
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Planning Episodes 

 

A podcast producer creatively undertakes research on various ideas and audio designs needed 

to make a successful podcast. As producer, you often wear many hats. Administrator and 

manager, scriptwriter and technical director, audio engineer and editor, publisher, promoter, 

and other behind-the-scenes interactions.  

 

You are responsible for overseeing the planning and production of episodes, guest research and 

interview planning, facilitation, direction and editing of recording sessions, publishing 

episodes, and providing support to your production team throughout the production process. 

 

 
 

During the planning stage you will need to think about how you might develop your scripts 

and running sheets and plan your interviews and recording sessions. 

 

You will also need to think ahead to the post-production phase, where you will need to edit out 

any extraneous material, mistakes, missteps, and glitches; stitch together different audio clips, 

add in music, transitions, sound beds, and SFX (sound effects). You will need to maintain audio 

quality with gain control (sound levels) and potentially apply other audio engineering 

techniques such as EQ (equalisation), compression or noise reduction. This phase can be very 

time consuming and difficult, however a well-planned and competent recording session will 

ensure a much smoother time for you in the post-production phase.  
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Structure Checklist 

Planning the shape of a podcast series involves several key elements to ensure consistency, 

style, and format throughout: 

 

 Centre Your Concept and Audience: Always start by centering your podcast's 

concept and target audience. What is the central theme or topic of your series, and 

who are you creating it for? Understanding this is crucial to maintaining consistency.  

 

 Episode Structure: Establish a consistent episode structure. This might include an 

introduction, main content, interviews, segments, and a conclusion. Decide on the 

order and duration of these elements.  

 

 Tone and Style: Determine the tone and style of your podcast. Will it be formal, 

informal, humorous, serious, conversational, or scripted?  

 

 Release Schedule: Plan a consistent release schedule. Whether it's weekly, bi-weekly, 

or monthly, sticking to a schedule helps build a loyal audience.  

 

 Segmentation: Define any recurring segments or features clearly. Consistent 

segments can provide structure and become audience favorites.  

 

 Sound and Production Quality: Develop a production plan & location(s) for 

recording that will ensure consistent sound quality throughout. This includes audio 

levels, background music, and intro/outro music. High production values enhance the 

listener experience.  

 

 Narration and Hosting: If you have hosts or narrators, establish guidelines for their 

delivery style and interaction. This helps maintain a coherent feel. 

 

 Content Planning: Outline your content for multiple episodes in advance. This 

allows you to foreshadow or reference previous episodes, providing continuity.  

 

 Engaging Storytelling: Plan how you'll tell stories or present information. Use a 

storytelling framework or format that suits your podcast's theme.  

 

 Transitions: Consider how you transition between segments or topics. Smooth 

transitions keep the listener engaged.  

 

 Guest Guidelines: If you have guest contributors, create guidelines for their 

involvement to maintain consistency in content and delivery.  

 

 Branding: Develop a visual and auditory brand. This includes cover art, logo, tagline, 

and intro/outro music. Consistent branding makes your podcast recognizable. 
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Content 

You don’t necessarily need to plan every second of your podcast, but it is good to know where 

you want to go with your story or interview.  

 

Prepare a list of topics you would like to cover for different episodes and think about what 

elements might be consistent across the episodes to unify them as a series. This could include 

having a regular presenter or presenters, a theme track, a standard introduction tag and/or length 

of episodes, or any number of consistent elements. 

 

Usually, you will begin your planning with an idea, and then plan your structure and develop 

your content around that idea. But sometimes a project might grow out of a bunch of raw 

(unedited or archived) audio recordings that you’ve had ‘lying around’ for a while. You could 

develop your podcast project by structuring your podcast around a concept that utilises the raw 

audio. Either way can work very well. 

 

 

       Listening Example: Concept determines content 
 

3CR’s We Weren’t Born Yesterday podcast series began with 

an idea to focus on the voices of LGBTQIA+ people from 

Vietnamese, Chinese, Arabic and Hindi speaking backgrounds 

and explore queer heritage, vocabulary and intergenerational 

connections in migrant communities in Australia.  

https://www.3cr.org.au/wewerentbornyesterday 
 

 
 

 

 
       Listening Example: Content determines concept 
 

3CR’s Black Gold podcast series began with a huge pile of raw 

content (assorted, rare audio recordings from the 3CR archives) 

from which the idea came about to develop podcast which takes 

the listener on a narrated journey from the 1970s right through to 

the present day with a look at how Aboriginal and Torres Strait 

Islander broadcasters at 3CR covered some incredible 

community events and significant political struggles. 

https://www.3cr.org.au/blackgold 
 

 
       Listening Example: Consistent elements 
 

3CR’s Yarra Elders Precious Memories podcast series is an 

oral history series featuring the voices of Elders from the 

Aboriginal Fitzroy community. Consistent elements in each 

episode include an ‘intro tag’ with an acknowledgement of 

country and cultural warning, an ‘outro tag’ with production 

details, and music ‘bridges’ and ‘sound beds’ that were 

selected by each participant to be used in their own episodes. 

https://www.3cr.org.au/yarraelders 
 

 

 

 

 

 

https://www.3cr.org.au/wewerentbornyesterday
https://www.3cr.org.au/blackgold
https://www.3cr.org.au/yarraelders
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Narrative Arc 

The narrative arc is a framework that describes the conventional shape of storytelling across countless 

cultures and genres. It typically begins by introducing the characters and settings, followed by an 

inciting incident that sets the story in motion. As the narrative progresses, rising action builds tension 

and conflict. This leads to the story's climax, where the central conflict reaches its peak. Afterward, the 

tension subsides in the falling action, and the story concludes with a resolution, providing closure to the 

characters and their arcs.  

 

While stories can take various forms and structures, this classic narrative arc remains a cornerstone for 

storytellers to engage, entertain, and enlighten their audiences. 

 

  

Podcasts are typically structured similarly to the basic narrative arc. A podcast intro establishes the 

podcast title, host(s), guest(s), topic(s), location, and any relevant background information. The inciting 

incident can be the hook or key question that draws listeners in, setting the theme for the episode. As 

the podcast progresses, the rising action might involve discussing the various aspects of the topic, 

gradually building depth and complexity.  

 

The climax in a podcast could be a moment of high tension, a major revelation that captivates the 

audience or the core of an in-depth interview or discussion. The falling action might include wrapping 

up loose ends or exploring the implications of the climax. Finally, the resolution in a podcast can involve 

summarising key points, final thoughts and takeaways, and providing information about where to next, 

upcoming events and promotions. 

  

Not all podcasts strictly adhere to this structure. Some may be more flexible and experimental in their 

storytelling, depending on their genre and content. However, the basic narrative arc remains a useful 

guideline for crafting engaging and coherent podcast episodes. 

 

Running sheets 

It is very hard to deliver a great podcast without planning. Planning is key to making a great 

podcast!  

 

A running sheet is a plan, or schedule, for each podcast that may include individually 

itemised content on a timeline/schedule such as: 
 

● Timing: Individual time stamps for each segment, and the overall linear time flow 

● Scripts for intro, midtros & outro, and interview questions 

● Where pre-recorded & edited content might fit 

● Music & SFX 
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Running sheet layout  

 

There are not really any rules for the running sheet. A running sheet can be as simple as a list 

of dot points, or as detailed as the templates provided here (or even more so). You can 

experiment with different formats and decide what works for you.  

 

The template outlined here is just one example of how you could do it. You can switch it up it 

however you want, and / or do something totally different if you prefer. It’s about breaking 

your podcast down into all its individual components, and then moving them around on the 

running sheet to plan for how your podcast will run. 

 

You could put your entire script—every word you will say—in your running sheet. If that 

works for you. Or you might like to have your script in a separate document (particularly if it 

is a long script) and simply indicate where it goes in the running sheet (include maybe the 

first sentence).  

 

RUNNING SHEET (SUGGESTED) TEMPLATE  

Podcast: 

Podcast Episode:  
 

 

Episode title 

Presenter names: Who will be presenting/narrating the podcast? 

 

Topic: Age approp language. Ageism, all ages contribute,  

 

Format/style: Panel Is it an interview, a panel discussion? A story? The 

news? 

 

Source  
each individual 

audio item including 

presenters, 

interview, music & 

or sound effects  

 

Script 

 
You can put the entire script in each section if 

that works for you 

Or, you can have your script in a separate 

document & just indicate where they go in the 

running sheet (the first sentence) 

 

Item Time 
you can 

estimate or 

leave blank 

the times in this 

section until you 

know for sure 

after final edits 

of each 

individual item 

Time 

Flow 
You can 

leave all 

this section 

blank until 

you know 

what all 

your 

individual 

item times 

are 

Podcast Tag Could include Acknowledgement to 

Country, cultural/trigger warnings, or 

general information about the 

podcast/series that features on every 

episode including project title, 

presenters name, organisation, URL etc 

  

 

THEME MUSIC    
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Intro Intro for this specific episode including 

topic and guests 

 

 

 

  

 

guest interview questions 

 

 

 

 

  

Midtro(s) Optional segues at any time during 

podcast which take a break from the 

regular programming for presenter 

announcements, music breaks, 

promotions etc. 

 

 

  

guest interview More questions 

 

 

 

 

  

Outro  

Back-announce guests & topic etc 

 

 

 

  

Theme music  

 

 

  

Outro tag Consistent to every episode, could 

contain information about where to find 

podcast, production info etc 
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       Listening Example: Running Sheet 

 

Listen to this example podcast episode from 3CR’s Accent of Women podcast and follow along 

on the running sheet 
https://www.3cr.org.au/accentofwomen/episode-201908200830/lets-talk-love 

 

RUNNING SHEET: Podcast Project  

Podcast: 

Episode: 

Accent of Women  

Let's Talk Love 

Presenter: Ayan Shirwa 

Guest: Bigoa Chuol, cultural curator of ‘Let's Talk Love’ 

Topic: 

 

Format: 

Upcoming Melbourne Writers Festival event called ‘Let's Talk 

Love’ hosted by Arts and cultural curator Bigoa. Featuring 

contributors of the book 'Growing Up African in Australia'.  

Interview 

 

Source  Script 

 

 

Item 

Time 

 

 

Time 

Flow 
 

 

Podcast Tag 

 

 

Ayan: Accent of Women would like to acknowledge the Kulin 

Nation: true owners, caretakers and custodians of the land from 

which we broadcast. We pay our respect to elders past and 

present, and recognise their unceded sovereignty. 

 

0.15 

 

0.00 

  

Intro 

 

 

Ayan: Hello & Welcome to Accent of Women, I’m Ayan Shirwa,  

 

0.05 

 

0.15 

 

MUSIC 

   

Theme music fade in and play a bit then fade under continuing 

intro as a music bed 

 

 

 0.05 

 

 0.20 

 

Intro cont… 

 

Ayan: When you hear the word love 

 

what comes to mind?   

 

Is it family? 

  

Romantic relationships?  

 

Friendships?  

 

Maybe even….. self-love?  

 0.35  0.25 
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On today’s episode 

 

 I sit down with Bigoa Choul,  

an arts & cultural curator,  

 

to help us make sense of a concept that is so polarising.  

 

Today’s episode is inspired by an upcoming event called ‘Let's 

Talk Love’ hosted by Bigoa Chuol 

For the Melbourne Writers Festival.  

The show also features contributors from the book 'Growing Up 

African in Australia'.  

 

 

MUSIC 

   

Theme music fade up again and then fade out 

 

 0.02 

 

 1.00 

Interview Ayan:  

I think it’s important to let our listeners know that you & I know 

each other, we’ve known each other for a while,  

but that’s not why I’ve brought you on the program. 

I’ve brought you on because you have an interesting show 

coming up. 

But before we do that, let’s start from the beginning. 

Let’s go all the way to the genesis: Tell me about little Bigoa. 

Bigoa: 

[interview commences] 

 

Ayan: What about your reading style when you were growing 

up, do you remember the books that stayed with you? 

 

Bigoa: 

[interview commences] 

 

Ayan: That sounds interesting, can you tell me more about that? 

 

Etc. 

 

7.00 

 

1.02 

 

 

midtro 

 

I’m Ayan and I’m speaking with Bigoa Choul,  

an arts & cultural curator, about her show ‘Let's Talk Love’  

For the Melbourne Writers Festival.  

 

 

8.02 

 

 

Interview 

continued 

 

   

 you’ve been listening to Accent of Women with Ayan & Bigoa 

Choul,  

talking about her show ‘Let's Talk Love’  

For the Melbourne Writers Festival.  
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‘Let's Talk Love’ is  on Saturday August 1st at 6.30pm 

The Wheeler Centre, Performance Space 

176 Little Lonsdale St Melbourne, 

you can get tickets at mwf.com.au 

 

You can find our Accent of Women podcasts at 3cr.org.au 

that’s all for. See you later! 

  

MUSIC 

 

Fade out 

 

 

 

 

 

Scripting Development 

 

WHO is presenting your podcast?  

How many VOICES will be included in the podcast?  

 

Are you going to do an interview? 

Discuss a topic?  

Talk about an event, present the news, or share some information? 

Is it a story?  

 

Are you going to use any music, or sound effects?  

 

WHAT are you going to say?  

It may be helpful to script in everything you are going to say 

—depending on the style of your podcast.  

However, you don’t want to sound like you are “reading” it. 

 

Write it, like you speak it! 

 

Basic Script structure 

 

● Intro: The first thing you say.  

Introduce and provide information about the podcast:  
o What is it called?  

o What is the topic?  

o Who will be speaking?  

 

● Midtros: Any comments you make during the podcast other sound sources 

 

● Outro: Back-announce:  
o Podcast title 

o What you talked about 

o Who was talking?  

o Where can people get more information, web links, community events coming up?  

o Say goodbye. 
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Intros 

You might include: 
 

● Acknowledgement to Country 

● Cultural warnings 

● Trigger warnings - helpline numbers 

● Title of podcast  

● What podcast is about 

● Title of episode 

● Topic of episode 

● Names of presenters / hosts 

● Interview guest names & connection to topic  

● General information about podcast 

o who – production team, organisation if applicable 

o what - podcast  

o why – why people should listen to it? 

o where – website, apps, socials 

o how - production information, recording location, funding bodies etc 

 

 

Midtros 

Midtros flag what’s coming up next, between the segments. They can also help to break up a 

monotonous flow, with extra information or side comments from the presenters. They might 

also include promotional information, or community announcements.  

 

 

Outros 

You might include: 

 

● Back-announce (repeat) important information, like the podcast title & topic, episode 

title and topic, presenter’s names, guest names. 

● Information about organisations or websites mentioned in episode 

● Community events coming up 

● Where to find the podcast series online website, apps, social media.  

● Relevant production, promotional and contacts. 

● Name of producer or funding body (who supported you to make this?) 

● Anyone you want to acknowledge or thank  

● Say goodbye 
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Invisible Scripting 

Invisible scriptwriting sounds so natural that your listeners won’t realise it’s scripted at all. 

Invisible scriptwriting is tricky, because writing to be read, and writing to be heard require a 

different thought process. However, it’s worth it because invisible scriptwriting: 
 

• Helps create your Podcast structure, ensuring you cover all points.  

• Ensures your content flows and engages.  

• Builds your reputation as a slick podcast host.  

• Gives you the roadmap to deliver confidently.  

• Cuts down on production time. 

 

Your podcast map should be linear. In other words, each step leads on naturally to the next. 

When you script your episode, keep the flow simple, logical and consecutive: 
 

• Use contractions if that’s how you normally speak: i.e., ‘won’t’ instead of ‘will not’ 

• Be plainspoken: don’t feel you have to be formal.  

• Cut the jargon.  

• Assume your listeners know your topic, but don’t dive so deep they can’t follow your train of 

thought.  

• Use short sentences, kept to one point or idea each.  

 
Source:  https://www.thepodcasthost.com/planning/the-invisible-podcast-script/ 

 

Script layout 

Words are just words when you are writing a radio script... the way they are read out is what 

makes them come alive for a listener...  

So, how can you write a script with expression...?  

It’s all in the layout!  

Here are some simple techniques and their impact: 

 

Bold:  

Bold can be used to indicate volume or emphasis. 

Underline: 

Like bold, underlining can also be used for important information or emphasis. It can also 

give a very “firm” sound to your voice. 

Italics:  

Italics often have a softer, lighter sound and are often used for quotes or titles. 

Colour: 

Some presenters use colour to distinguish between key words, key points, or segments. Be 

careful though. Yellow is very hard to read, and problems happen when scripts are 

photocopied in black and white. Or sometimes a presenter will only read black text and 

ignore the words in colour all together! 

 

https://www.thepodcasthost.com/planning/the-invisible-podcast-script/
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Paragraphs:  

Paragraphs can be used to give the presenter an opportunity to take a breath or pause between 

ideas. 

Punctuation: 

Full stops or periods can be used to indicate a pause... either for a breath... or for dramatic 

effect. 

Spacing 

Spacing can help to change the tone of your presentation.  

Having text centred from the left margin can produce a more serious sound. 

Whereas centring the text can sound more impromptu and lighter. 

Double spacing is also easier to read from a distance. 

 

Size 

Size is helpful to read things at a distance, it can also affect the volume of the 

reader. 

 

Font 

Sounds silly but different fonts can affect the tone of your voice. 

Fonts like Times New Roman can make the script sound more serious, useful for news and 

current affairs. Whereas Century Gothic sounds more light-hearted. 

 

Phonetic Spelling 

FO – NET- IK spelling shows how the word should sound.  

 

This is useful for words from an unfamiliar language or words that are DIFF – EE – CULT to 

say! 

It can also be extremely helpful to phonetically write out place names, and guest’s names that 

you find difficult to pronounce. Please avoid disrespectfully mispronouncing someone’s 

name, or awkwardly asking them how to pronounce it during the show. 

 

Numbers as words:  

With numbers over 100, like $1,000,837.40 always write the number in words  

e.g., one million, eight hundred and thirty-seven thousand dollars and forty cents.  

 

Or even, better, round the number up  

e.g., Just over a million dollars. 
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SCRIPTING TIPS 

 

Role of the Script:  

Should give listeners the impression that they're being spoken to rather than read at. A 

podcast is a spoken word performance. 

Think – Say – Write:  

Speak the script aloud as you write it. Think about what you want to say, then say it out loud, 

write it down, and then say it again. If you can't read the script without stumbling over parts of 

it, rewrite the script until you can say it easily. 

 

Conversational Language:  

Should be conversational - not sloppy, but more colloquial than the written word. The way you 

speak is the way you should write the script.  

 

Build Visual Images:  

Tell stories, build pictures, and use descriptive language for colour and meaning. 

Capture Your Listener  

Capture your audience with your very first words and ‘keep hooking them in’. Start with an 

intriguing idea or ‘audio grab’ to entice your listener to stay with you and follow with 

explanation. Build up to a good ending - present your conclusion in a way that will be 

remembered by the listener. 

 

Key Words & Ideas:  

Know what the key words or ideas are and make sure they will be heard. Tell the listener what 

to expect during your podcast. End with a summary and a reference to the main points to 

reinforce what you've said. 

 

Item Length: 

Podcasts demand a concentration and attention span greater than most other media. Limit 

each idea to approximately five minutes before a mental breathing space is provided; the 

break can be a scene change, a new voice, a new tempo, or the use of bridging music.   
 

 
(Source adapted: Radio Adelaide Training Manual, 12th edition 2009) 

 

 

 
 Scripting resources 

● Storyboard That  storyboardthat.com/storyboards/oliversmith/flowchart-6 

● IJ Net  ijnet.org/en/resource/how-write-broadcast-news-stories 

● Live 365  live365.com/blog/how-to-write-a-script-for-your-live-radio-event 
● Voices.com  voices.com/blog/planning-your-podcast 

● NPR  training.npr.org/2018/05/07/a-blueprint-for-planning-storytelling-projects 

 

  

https://www.storyboardthat.com/storyboards/oliversmith/flowchart-6
https://ijnet.org/en/resource/how-write-broadcast-news-stories
https://live365.com/blog/how-to-write-a-script-for-your-live-radio-event/
https://www.voices.com/blog/planning-your-podcast/
https://training.npr.org/2018/05/07/a-blueprint-for-planning-storytelling-projects/
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Interviewing 

When choosing your topic and guest(s), and planning your interviews there is a lot to 

consider. Every guest will be different. You will need time for consultation with your guest, 

for planning. You will need to check-in with your guest before and after, and you will need 

informed consent at every stage of the interview process. 

 

 

PRE-INTERVIEW DISCUSSION/CHECK-IN: 

 

 

What is it?  

An informal consultation with guests/interviewees in a safe environment (not recorded) that 

happens before the recorded interview. 

 

What are its aims? 

1. Introduce yourself (if you haven’t already), your organisation and/or your project. 

2. Establish trust and consent (e.g., boundaries for topics, time and energy) 

3. Gives a framework/aims for developing questions (see below: 5 W’s and H method) 

4. Learning about your guest (e.g., how do they speak?) 

 

Examples of things to say in the pre-interview discussion 

• Ask guests what they would like to gain from interview experience? (i.e., promote 

campaigns, raise awareness, share stories etc.) 

• Are there any topics that you think are important to cover during this interview? 

• Discuss your own aims for the interview, with a focus on shared aims. Do you and 

your guest have the same goals?  

• Are there any topics you are not comfortable to discuss in this interview? 

• Are you comfortable sharing your identity? If not, we can avoid personal information 

and/or provide a voice substitute [somebody else reading the guest responses] 

 

Activity 1: Can you think of other questions to ask in the pre-interview check-in? 

Activity 2: What would your preferred place be for this discussion (email/phone/zoom/in 

person)? 

Activity 3: How long before your interview would you have this discussion?  

 

CONSTRUCTING INTERVIEW QUESTIONS: 

• 5W’s and H method: WHO, WHAT, WHEN, WHERE, WHY, HOW? 

• Always return to the information you gathered during your pre-interview check-in! 

 

Activity 4: Why do you think we follow this order in interview questions? 

We follow this order because some are more suited to the beginning/middle/end, but you 

don’t have to ask all of the questions - this will come up as you are recording (in “tips” 

document).  

 

 

Activity 5: In order, can we think of questions for each of the “5W’s and H” method? 

• Who/What: Who is the guest & what is the topic / subtopics? 

e.g., ‘Hi, could you please start by telling listeners your name, and what your 

connection is to [the interview topic]?  
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• Where: Current location, place of origin, organisation, event: e.g. What organisation 

are you from? 

 

 

• When: Is the interview about something that occurred in the past, something that is 

currently happening, or something that is coming up in the future? 

e.g. When did this story take place? When did your study/report take place? 

 Present: What are you doing at the moment? Could be work/training 

 Future: Is there an event/workshop taking place?  

 

 

• Why: why do you think this discussion / topic is important?  

e.g., If you have one key message for listeners, what would it be? 

e.g., Would you like to share with us: why it is important to talk about your story?  

e.g., What are common challenges with having conversations about this topic? 

[specific to “pitch”/pre-interview discussion] 

 

 

• How: Call to action 

e.g. Are there any resources that you would recommend for listeners that have helped 

you? 

e.g. How can listeners get involved or find out more?  

e.g., How can we attend the event/ locate the resource/ approach conversations in 

future?  

 

 

• Always thank your guest at the end of the interview for sharing  

 

TIPS FOR INTERVIEWING 

 

 

• Ask open-ended questions using words like "who," "what," "when," "where," "why," 

and "how." Avoid using words that may solicit simple yes or no responses, like "Are 

you," "Did you," and "Would you." 

• Focus on asking relevant questions. 

• Tap into what your guest wants to talk about 

• Always include a variety of questions to keep it interesting. 

• Be mindful of sensitive or emotional topics. 

• Let your topics and research guide your questions. 

• Think about what your audience wants to learn. 

• Remain open-minded and non-judgemental. 

• Have a pen and paper handy to jot down follow-up questions. Break long questions 

into smaller ones.  

• You may not get time to use all your prepared questions and that is okay. You could 

create a list of priority questions, and a separate list of optional / bonus questions, to 

ensure that you cover all the most important topic points during your interview. 

 

 

POST-INTERVIEW DISCUSSION/CHECK-IN: 
 

What is it?  

A discussion after the interview with your guest (not recorded) to thank them and check in 

about their consent and support. Offer for them to listen to the edited podcast before 

publishing if they want to (time/energy). 
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What are its aims? 

1. See whether they still consent to publishing content 

2. Inform guest when / where / how they will be able to listen to the interview 

3. If relevant / necessary, check-in with guest to see if they have post-interview support  

Examples: 

• Would you like me to send you the final edit of this podcast before I publish it? Is 

there anything from the interview that you would like me to remove when I am 

editing? 

• Do you have someone you can call if you need to debrief after this interview? [you 

can also share resources, e.g., Lifeline or 1800Respect 

 

Interview checklist  

Choosing your topic & guest:  

□ Consider your target audience  

□ Research your topic  

□ Develop an angle / approach  

□ Draft a list of key points  

□ Research potential guests—check that they’re a good speaker / right person to interview 

 

Preparation:  

□ Contact your potential guest & have a chat  

□ Brief your interviewee on what to expect:  

□ Purpose of interview  

□ Location, Time and date, Duration,   

□ Key points for discussion 

□ Confirm Guest 

□ Refine your interview angle topic points based on what you learn from the chat 

□ Draft interview questions based on topic points (introduction, warm up question, 

subsequent questions building up in-depth & windup)  

□ Check they are in logical sequence  

□ Consider how the interview should end.  

□ Check recording equipment before the interview  

During the interview:  

□ Ask them to state their name and position for the record so you get the pronunciation 

correct  

□ Listen! Don’t speak over the top of each other. 

□ Respond with natural, concise questions  

□ Keep quiet while the interviewee is talking  

□ Keep an eye on the levels  

□ Keep focused  

□ Keep to time  

□ Look for a good out point  

□ Wrap it up  

□ Thank your guest  

 

After a pre-recorded interview:  

□ Save your interview file immediately.  

□ Check that interview recorded correctly – repeat if necessary  

□ Edit for a natural / smooth sound  

□ Change the scripted intro if necessary  
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Structuring your interview  

Listen to a range of interviews and use this checklist to decide if the interviewer does the 

following:  

 

INTRODUCTION  

□ Does it catch the listeners’ attention?  

□ Does it sound scripted?  

□ Does it introduce the topic clearly?  

□ Does it introduce the speaker clearly and pronounce their name, title & position correctly in 

the context of the interview?  

 

BEGINNING  

□ Does it get straight to the point? Or are there “settling down” questions?  

 

MIDDLE  

□ Ask one question at a time?  

□ Are the key issues or focus of the interview identified?  

□ Following through on the introduction?  

□ Listener friendly/ rapport with the speaker?  

□ Control without domination?  

□ Are there “unasked questions” for you?  

□ Is there a reminder during the interview of the guest’s name?  

 

ENDING  

□ Not too sudden or abrupt; long or too short?   

□ Ended on a strong note?  

□ Back announced with details and summary including how to find out more information 
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Interviewing on sensitive topics 

  

Safe storytelling principles 

When conducting interviews on sensitive topics, it can be helpful to be mindful of safe 

storytelling principles to create a respectful and empathetic environment for your guest. By 

prioritising safety and choice, you can ensure that participants feel comfortable sharing their 

experiences and have the autonomy to decide what they're comfortable discussing. Key 

aspects include: 

 

 

• Consent and Choice: Give your guests autonomy to choose what they want to share 

and how much they want to disclose.  

• Emotional Safety: Create an atmosphere where participants feel safe expressing their 

feelings and experiences without fear of judgement or harm. Active listening & 

empathy. 

• Respect for Boundaries: Acknowledge / respect limits set by guests prior to 

interview, and don’t push guests to share details they are not comfortable discussing. 

• Transparency: Be clear about the purpose of the interview and any potential 

consequences, such as public sharing or publication. Allow space for questions and 

clarifications. Transparency builds trust. 

• Confidentiality: Ensuring that off the record comments & stories are kept private and 

confidential unless explicit permission is given to share them further.  

• Empowerment: Give guests agency in shaping their narratives and the direction of 

the conversation, value their voices and perspectives, and foster collaboration. 

• Support and Resources: Provide contact details for professional support services 

when needed. 

 

Sensitive Interview Process 

 

These steps can take up a lot of time—allow plenty of time for the sensitive interview 

process. 

  

First contact: Informed Consent—be honest with your guest about everything 

• Treat an interview like a relationship  

• Who are you (in your role as interviewer)? 

• Where are you from (publisher—e.g., 3CR Community Radio)? 

• Why are you producing this story? What is your connection to the issue? 

• What key topics do you want to cover, and what will be your angle / political 

position?  

 

Further information when guest expresses interest: 

• What kind of interview space will you provide (including access requirements & 

safety)? 

• How will the interview process proceed: Before, during and after? (Structure, check-

ins and guest’s power of veto) 

• How will the interview be conducted? What can your guest expect? 

• How can your guest let you know if they are uncomfortable, or want to pause, or end 

the interview? 
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Before guest interview: 

• Provide guest with bullet points of discussion topics/questions and discuss if okay 

• Provide guests with the option of workshopping discussion topics or questions with 

you if they wish to and have capacity to do so. 

• Avoid judgemental or blaming questions 

• Use open-ended questions. Let guests know that they’re not required to answer 

questions 

• Continue to build trust and rapport in your relationship with your guest 

• Maintain check-ins re consent and support 

  

Identity 

• All interviews require prior discussion about how guest would like to identify in 

context of interview—but sensitive topic interviews require extra care 

• Discuss with your guest if they will need to use a fake name, voice distortion or a 

voice substitute (i.e., someone else voice reading their words). Will you need to take 

any other steps to protect their identity if required for safety reasons (e.g., omit 

locations, other names and other identifying information?) 

  

During interview 

• Allow an open-ended amount of time for interview 

• Begin by thanking guest for speaking with you 

• Remind guests they’re not required to answer questions or talk about topics they don’t 

want to talk about—even if they previously agreed to do so. 

• Let guests know they can take as much time as they need. Pause interview when 

needed. 

• Begin interviews with non-sensitive topics, to establish rapport and allow listeners to 

get to know your guest. 

• Let the silence sit when needed, and always give your guest time to finish their 

thought or tell you what they need to tell you. 

• Avoid judgemental or blaming questions/comments 

• Respond with affirmatives: “I hear you.” 

• Nonverbal cues, like sympathetic facial expressions, nodding, or a thumbs-up can be 

helpful. 

• Towards the end of the interview try to ground your guest back into the present 

moment. For example: 

o What is your day-to-day life like now? 

o What do you do to unwind and feel safe? 

o What’s the best part of your life right now? 

o Tell me about the last time you laughed really hard? 

o Do you have any plans for after this interview? 

 

 

• At the end of the interview, remember to say, ‘Thank you for sharing this with me.’ 

 

 

 
NB: Be mindful that your guest may need breaks within the interview, or they may need to end for the 

day and come back another day. Building trust and rapport can take time. Maintain “check-ins” 

regarding consent and support. 
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Postproduction 

• Let your guest listen to and approve interview before you publish 

• Make any changes they recommend 

• Provide them with the right to veto the whole interview before or after publishing if 

they need to 

• Maintain check-ins regarding consent and support 

  

Self care & boundaries 

• Always refer guests to professional support if needed—you are an interviewer, not a 

counsellor. 

• Work safely and maintain check-ins with yourself regarding triggering and support. 

 

 

Content Warnings about sensitive issues 

 

As broadcasters we need to be mindful about the content we air and possible negative affects 

for listeners. There are a range of issues that may bring up difficult emotional responses to 

traumatic experiences that people have had or are experiencing now. These issues may 

include the following topics: Violence, domestic/family violence, sexual assault, incest, 

torture, self harm, eating disorders and suicide. 

 

When reporting on the above issues podcast producers may decide to include a warning for 

listeners about the topic being discussed so that listeners can opt to tune out. You can give the 

warning in a way that suits the sound of your podcast. It does not have to be too formal if 

your presentation style is generally a relaxed style. It is good to find a balance between being 

too general such as the phrase “adult themes” and being too explicit and thus triggering a 

response whilst listening to the warning. 

 

An example of warning is from the 3CR Women on the Line program ‘Body is a 

Battleground’ produced by Aoife Cooke and Elena McMaster: 

“This program features stories of a sexual nature, if that doesn't sound like your cup of tea 

right now you can turn off your radio or listen later in the privacy of your own headphones. It 

also references sexual assault and may be triggering so please take care." 

 

When discussing sensitive issues, it always important to give out information about help lines 

that people may call for example: 

Women’s Information and Referral Exchange (WIRE) ph.: 1300 134 130 
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Reporting suicide and mental illness responsibly 

 

This appendix is for guidance only. Suicide is a prominent public health issue in Australia 

with over 2,000 people dying by suicide each year. 

Some important facts about suicide are: 
• Rates of suicide are generally three to four times higher among males than females 

• Many more people attempt than die by suicide with hospital admissions for intentional self 

injury about ten times as common as deaths by suicide 

• Migrants in Australia show similar suicide rates to those in their country of origin 

• People in any form of custody have a suicide rate three times higher than the general 

population. 

• Mental illness is a major risk factor for suicide with psychological autopsy studies showing 

that up to 90% of people who suicide may have been experiencing mental disorder at the time 

of their death. 

 

Issues to consider when reporting on suicide: 
• Should I run the story—what value can be gained from doing so? 

• Be careful with the language you use 

• Don’t be explicit about the method or location of suicide 

• Discussion of celebrity suicide can glamourise suicide 

• Consider the angle (or positioning) of the story 

• Should you interview the bereaved? Is it necessary? 

• Place the story in context 

• Include helpline contacts in your story for example: 

If you need immediate assistance, call Lifeline on 13 11 14. For further information about 

depression talk to your GP, local health professional or someone you trust. 

 

 

The Mindframe Media and Mental Health (MMMH) project 
 

Mindframe is one of a suite of projects on suicide, mental illness and the media developed as part of 

the national media strategy. MMMH aims to build a collaborative relationship with the Australian 

media and mental health systems to enable a more accurate and sensitive portrayal of suicide and 

mental health issues across all news media in Australia. A key activity of MMMH is the development 

of a resource kit for use by media professionals. It is available from: 

www.mindframe-media.info 

 

  

http://www.mindframe-media.info/
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Access & representing Disability 

Ask your guest how they want to be introduced or described on air. Even if the interview is 

about a disability-specific issue, your guest may not wish to be defined by their identified 

disability(ies). They are best placed to determine if it’s relevant to mention it. 

● “Joanna Bloggs is spokesperson for Equal Access to Public Transport” 

● “Joanna Bloggs is spokesperson for Equal Access to Public Transport and a 

wheelchair user” 

 

Avoid representing disability as a tragedy by using words such as "suffers from" or "afflicted 

by". Avoid describing the activities of People with Disability as “heroic” or “inspirational”, 

on the basis of their disability. This kind of narrative may risk implying that People with 

Disability who are not currently very active are somehow “less than”. It should not be 

surprising when Disabled People are active and “achieving”, and it is also okay if they are not 

particularly active and “achieving”.  

 

Always make sure the voice of the Person with Disability is heard. While your guest might be 

accompanied or assisted by a support worker or friend, it’s important to focus on your guest 

during the interview. There are many resources online about portraying People with 

Disability. The Victorian Department of Human Services has developed the “Reporting it 

Right” guidelines to assist journalists to portray People with a Disability appropriately. 

 

Practical tips: 
● Confirm prior to the interview with your guest about any access needs, including wheelchair 

or scooter access to where the interview will occur and if this access is available (including 

appropriate toilet access!). Advise guests of accessible entry points to the location. 

● Schedule in prep time to offer your guest a tour of any equipment to be used, particularly if 

your guest has low or no vision. 

 

Explain where you will be sitting in relation to your guest during the recording and agree to 

any visual or verbal cues to be used. Remember that people with low or no vision may not 

know where you are once, they have headphones on. 

 

Guests from the Deaf Community may require a sign language interpreter. Check if the guest 

will provide an interpreter or whether you will need to arrange (and pay for) an interpreter. 

 

Some guests may have difficulty speaking clearly for the length of time required. If this is the 

case, one option is to ask your guest if they would prefer to prepare a script and choose 

someone to read it for them – but it is good practice to ensure your guest’s voice is still heard 

during the recording if they are comfortable with this option. 
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Production 

It is possible to make small, half-decent, zero-budget podcasts on a smart phone or tablet 

using good mic technique, high quality recording settings and audio editing apps (like Lexis 

Audio Editor or WavePad)—you can even add music.  

 

However, to make a good quality podcast you will need better equipment, and especially 

better microphone options! You will also need a laptop or desktop computer with plenty 

of free storage capacity, to run your audio editing app and for storing active audio projects.  

 

You should always leave at least 100GB free on your hard drive—don’t work with a full 

hard drive, it will cause all kinds of problems for you. You should get an external hard drive 

and or cloud storage online to archive audio projects and files that you are not currently 

working on, and to back up important projects.  

Suggested Equipment 

- Laptop or desktop computer  

- External hard drive and/or cloud storage 

- Audio editing software: Audacity is an excellent open source (free) app for beginners 
https://www.audacityteam.org/download/ 

Reaper is a relatively cheap option, and other industry standard options include Adobe 

Audition, Pro Tools, Ableton, and Logic Pro. 

- VOIP software for remote interviewing: e.g., Zoom (best free option).  

- Good quality studio headphones (minimum $20 to $30—better if you can afford) 

 

Microphone Options 

The internal microphone on your laptop or smartphone is limited regarding high quality 

recording. If you want a really high-quality podcast  we recommend that you get an external 

microphone(s). There are a few options including: 

- USB microphone  

- USB headset with microphone 

- Analog headset with microphone & audio jack/XLR connecter (needs 

USB digital interface or mixing desk to record to computer—see 

digital interfaces below)  

- Analog microphone (unidirectional) with XLR connecter (needs USB 

digital interface or mixing desk to record to computer—see digital 

interfaces below) 

 

Microphone Accessories 

- XLR leads, microphone clips and stands. 

- Windsocks and pop filter/s can make a big difference with avoiding unwantedpops 

and hisses.  

https://www.audacityteam.org/download/
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- Depending on your set up and recording requirements you may find that you also 

need other cables, adapters and/or splitters.  

- Gaffer tape and a long electrical cable extension can be useful for location recording 

 

Devices and Digital Audio Interfaces 
 

 

 

Portable digital recorders are a versatile 

option. They have native mics that often 

work quite well, especially for atmospheric 

sound recordings.  

 

However, you will get better sound with 

vocals if you attach an external microphone. 

If you plan to do a lot of interviews you 

should get a portable digital recorder with at 

least 2 external mic jacks. 

 

 

 

 

Your external (analog) microphone will 

need to run through an audio interface 

device to record directly to your computer 

via USB. 

 

This picture depicts an analog headset with 

microphone connected to a Behringer USB 

audio interface via an XLR cable.  

The USB interface converts the analog 

audio signal (recording data) to digital and 

sends it to your laptop via the USB 

connection.  

 

You can control the sound levels on the 

USB interface while you are recording and 

monitor them on your audio software on the 

computer. 
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A mixing desk is great option for advanced 

podcasters because it allows for precise 

control and adjustment of audio levels and 

offers multiple input channels for 

microphones and other audio sources. 

Additional features like EQ (equalization) 

can enhance your recording process by 

correcting frequencies and controlling 

volume fluctuations, resulting in 

professional-grade production. Moreover, 

mixing desks often offer monitoring 

capabilities, allowing podcasters to listen in 

real-time and make immediate adjustments 

for optimal audio clarity and consistency. 

 
 

 

 

 

       Further reading: Checkout Transom’s Gear Guide  

 

 

Getting Audacity 

Audacity is a widely used open-source and cross-platform software for recording and editing 

sounds. 

 

To download the latest version of Audacity for Mac OS, Windows or 

GNU/Linux the link is here, it's FREE (open source). 

 
Older versions: 

Audacity developers are constantly updating and refining the program. If you have an old 

version of Audacity, don’t mess around with it. Just uninstall your old version of Audacity 

and then install the latest version. You will thank yourself once you get familiarised again!  

 

  

https://transom.org/2020/gear-guide-for-a-lockdown/
https://www.audacityteam.org/download/
https://www.audacityteam.org/download/
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Setting up a DIY/home space for recording 

 

If possible, choose a small-medium and cosy room/area to record in (bedrooms can be best) 

with a lot of soft surfaces – i.e., carpet, drapes, couch, bed, clothes. Avoid recording in 

kitchens and other areas with floorboards, tiles, too many hard, bare surfaces, glass doors, 

large windows with no curtains or blinds, spacious or high ceilings etc.  

 

If you don’t live alone: Avoid recording in/near other busy household areas (kitchen, tv area, 

bathroom & toilet, thoroughfares, noisy doors opening and closing regularly). Ensure that no 

one will interrupt you, have a conversation nearby, prepare food (i.e., knife chopping, kitchen 

appliances etc.), vacuum the carpet, take a shower, run a tap, or flush a toilet near you (or any 

other annoying background sound!). Make a “Quiet - recording in progress! Please don’t 

disturb” sign to put on the outside of the door when you close it and begin recording - to 

remind people. 

 

If possible, avoid outside noises: traffic, trams, trains and aircraft sounds, lawnmowers, dogs 

barking, kids playing, birds squawking etc (unless you’re going for ambience; then consider 

the proximity of those background sounds to the central focus of your own voice and do a 

sample recording first to see how it sounds). 

 

 

  
 

 

 

Try laying a blanket or towel on your 

desk/table/other surface under your equipment, 

to help to soften the sound and muffle echoes 

& reverberations. Sit on your bed in with 

recording equipment on your mattress, and 

arrange pillows & duvets etc all around you to 

record. You can also sit completely under a 

blanket or duvet (just make sure its not rubbing 

against your mic!), or with your mic facing 

inside a built in wardrobe with lots of clothes in 

it. 

 

Turn off the air-conditioner and any other 

machines that make background “humming” 

sounds. Cover up any remaining hard surfaces 

with fabric and close the curtains or pull down 

the blind if possible. Ensure that you aren’t 

wearing any fabric that rustles when you move 

(or jangly bling!) 

 

If your computer is working overtime and sounds like an airplane about to take off, then shut 

it down for 5 minutes, restart it and ensure that the only app you have open is your recording 

app, before you start recording. 

 
https://www.podcastmotor.com/ultimate-guide-recording-great-sounding-audio-podcast/ 

https://sarahmikutel.com/how-to-podcast/podcast-recording-environment-studio 

 

  

https://www.podcastmotor.com/ultimate-guide-recording-great-sounding-audio-podcast/
https://sarahmikutel.com/how-to-podcast/podcast-recording-environment-studio
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Choosing a microphone for podcasting 

Any decent portable digital recorder will probably have reasonably good native 
microphones, but to get a really good podcast sound you need at least one really good 
external microphone (& ideally two for interview situations). The two factors that 
determine what external microphone you should go for are: 
 

● Your budget 
● Your recording environment 

 
Budget: As with everything, the more you spend, the better the quality you'll get. But this 
only goes up to a point. When upgrading, you can spend a lot, but you also need a lot of 
knowledge and more professional support equipment to take advantage of the quality of 
really high range microphones—so save that for a couple of years down the line when 
you've become an audio production expert and stick with something around the $150-
300 range when starting out. 
 

 
 
 
Recording environment: The question of dynamic verses condenser microphone 
comes down to where you normally record and how much kit you want to use. 
 
Dynamic Microphones are probably the best choice when you are starting out because 
they are more versatile. Dynamic mics record a narrower range of frequencies and less 
surrounding noise, so you have to be right up close to the mic when you use it and the 
sound is less rich than condenser mics—but because of that they can be much more 
forgiving in a wide range of recording environments—and so they are a better choice 
for location and non-studio based interviews. 
 
If you are planning on building a DIY studio, and you want that extra level of depth to your 
podcast, it could be worth getting a condenser microphone - but with some caveats. 
Condenser microphones can introduce a higher level of quality to your recordings, but 
only in the right context. Because of their sensitivity, condenser microphones pick up a 
lot of background noise. This means you need a studio recording environment to take 
advantage of the quality they offer. Condenser microphones also tend to be a lot more 
fragile, so they're no good for carrying around in your bag. You won’t be able to take it 
anywhere easily. The other disadvantage is that condenser microphones need external 
power. This normally comes through a phantom power supply, provided by either a 
mixing desk, a portable digital recorder that is compatible with the condenser mic, or an 
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internal battery powered condenser mic. Essentially, if you want the best quality and plan 
to record (using a mic stand) in a studio environment, then a condenser microphone 
could be great for you—but it will require a moderately advanced skill level to set this up. 
 
Unidirectional, bi-directional or omnidirectional microphone? 
 
Condenser and dynamic microphones can both be unidirectional, bi-directional, or 
omnidirectional. For example, a “boom mic” is condenser & directional using phantom 
power—super powerful! 
 
In just about any setting, and particularly one with bad background noise, your key 
factor is microphone technique. For interviews, that means getting the user close to the 
mic, raising their level, and making sure it drowns out any background noise. So for 
interviews you want at least one good directional microphone (and ideally two - if 
your PCM recorder has 2 microphones jacks/XLR connections). If you get two then you 
need at least one mic stand, because you don’t want you guest to hold their own mic. 
They won’t know how to do it, and it will mess with their levels and pick up every little 
movement as noise interference! 
 
Also, you want your speakers to be right up close to the microphone/s when speaking 
(but not too close—watch out for sibilance and popping!). So, if you have only one 
microphone, then make sure that you instruct them to wait until you get the mic back 
over to them before they start to answer your question (but don’t let them take the mic 
from you, rather hold it up to them so that you can control the proximity at all times) 
 
Omni-directional or bi-directional microphones may be productive for recording 
surround sound effects (i.e., room ambience, a flock of seagulls, a busy street or rain 
falling)—but again, having an expensive range of different kinds of microphones is 
pointless if you don’t really need them, or you don’t have the skills and set-up to take 
advantage of their capacities. 
 
Some microphones can switch between directional, bi-directional, and omni-directional, 
which could be useful for experimentation. 
 

Conclusion: A dynamic and unidirectional 
microphone (or two if viable) for around 
$150-300 per microphone is probably the 
best option for starting out with DIY 
podcasting – but it’s also worth knowing 
that there are other options out there. 
 
When you go to buy your microphone/s take your 
portable digital recorder & headphones with you 
so that you can test for compatibility and sound 
quality before you make your purchase. 

 



3CR Community Radio - Podcasting Handbook, 2024   page 36 of 70 

 

Setting up your recording device  

Here are some basic universal tips for setting up your equipment to record, whether you are 

using a portable recorder or a laptop/computer (with soundcard/digital interface, USB mic or 

headset)—or even just your mobile phone or tablet) 

 

 
Plug in your headphones and external microphone (mic) if using and turn the power on. 

 

Check that all internal and external settings are correct according to your device manual 

instructions for recording. 

Podcast Recording Settings 

Record your file at a minimum of 44100kHz, 16-bit, mono wav file (go into your device 

settings or recording app settings to do this). 
 

Audio format: ALWAYS record in wav format!! (Sometimes called PCM)  

Channel: stereo or mono, depending on your requirements 

Sample rate suggestions:  
• Minimum settings for good quality sound: 44100Hz (or 44.1kHz) frequency & 16-

bit or 24-bit rate 

• Maximum settings for good quality sound: 48000Hz (or 48Hz) and 32-bit rate  

NB: If your device will only provide you with settings lower than 44100kHz and 16-bit it is not 

suitable for podcast production. 

Recording on a portable recorder 

- Press the REC button on your device or app 

- Check and adjust your sound levels—also known as gain 
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- Record (and edit) spoken word and ambient sounds (atmosphere & SFX) to a 

maximum level of -6 decibels (dB) and a minimum of -12 decibels (dB), thus 

allowing ample space to accommodate any fluctuations but not risk the sound levels 

peaking or receiving a weak signal—on many devices and apps a red OVER light will 

flash if the levels are peaking, and a green/yellow light will indicate good levels. 

- You can record (and edit) music levels / gain to a maximum level of -3 decibels if 

the bass distortion is really ‘fat’ (e.g., rock, punk, techno or hip-hop etc.) but be 

careful not to clip it or distort it too much. 

- Once you finish, press STOP and save the file  

- For playback, use the PLAY button on your device or app 

Transferring your recorded audio file from a portable recorder 

You can usually transfer a file directly from a portable recorder onto the computer via USB 

cable. This is recommended even when you are using an SD card on your device, as 

continually removing and reinserting the SD card can damage the SD port, rending your 

device useless.  

Firstly, turn the recorder power OFF. Plug the USB cable into the recorder and to the USB 

port on the computer and then turn the recorder power ON.  

 

 

5 Steps to Recording 

1. Plug in microphone and headphones 

2. Turn Power ON 

3. Check all settings are correct 

4. Press REC button, test levels 

5. start recording and monitor levels remain between -6 dB and -12 dB 

Microphone Technique 

 

Always record with headphones on 

and watch your sound levels.  

 

Get close to the microphone, with 

your mouth about 5 to 10cm away 

from it. 

  

Be careful handling the microphone, 

watch out for squeaky chairs and 

paper noises. Don’t move your mic 

while speaking Don’t speak over top 

of other presenters or guests. If you 

accidentally do this, then pause & 

start again. 
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Remote Interviewing in Zoom Tips 

 

Setting up a recording space for remote interviewing 
 

Preparing yourself and your guest—help them to set up their own home studio! 

 

It is essential for both you and your guest to be in a quiet location for the interview, with no 

interruptions. Pre-arrange this with your guest before the day of the interview. It's important 

you feel confident to do this, as they are relying on you ensure that their interview sounds as 

good as possible, and they won’t mind complying with your requests for this reason. Provide 

them with the following tips for choosing a room to record in and softening the space 

 

If possible, both you and your guest should conduct the interview in the smallest and 'softest' 

sounding room (with low ceilings) available to you both. Large empty rooms with high 

ceilings and too many hard surfaces—such as walls, windows and polished surfaces—

reflect sound and create a hard echoed recording.  

 

Ideally you want a room filled with lots of furniture or storage items, and with carpet (or rugs), 

as this helps to soften the sound. If you have floorboards, you could lay blankets over them. 

You could also try setting up your recording equipment/device under a table or in a walk-in 

wardrobe, with soft blankets or clothes hanging all around you. 

 

You and your guest may be accustomed to facing a window for the light during zoom 

conferencing—however, if video is not necessary for your podcast, you won’t need to worry 

about lighting. You and guest should turn the video off during the interview for a smoother 

connection, and cover any windows with blinds, curtains, or blankets to soften the room 

sound and avoid echoes. 
 

You and your guest should also create a 'soft space' around your microphone/recording 

device. Cover table surfaces with a towel or blanket. Replicating a sound booth by building a 

little wall around your microphone/recording device using cushions and pillows can really 

help.  

 

Allow plenty of time before your guest logs into Zoom to set up your recording space and 

adjust your own Zoom settings (as per following instructions) if necessary. 

 

Pre-arrange with your guest to allow ample time for them to set up their recording space, 

before they log on to Zoom, and for you to go through their Zoom settings and sound check 

with them before the interview commences. 

 

  

Internet Connection 

 

The quality of the audio may also be affected by the quality of your and your guest’s internet 

connections. This is almost impossible to control, so you should try to schedule an interview 

time when the internet traffic is lower.  
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If the internet connection is still very bad you should reschedule, and/or try a different 

recording location with a better connection.  

 

If you are pressed for time. you could email the questions to your subject and have them 

record themselves on offline on their laptop or phone using a recording app, and then send 

you the audio file. You can record the questions separately and then edit them together in 

postproduction. If you go with this option, you will still need to guide your guest through the 

settings in their recording app.  Ensure that their app records in WAV format to the highest 

quality settings available.  

 

Both you and your guest should also record I minute of the “atmosphere” sound in your 

respective recording spaces before and/or after the interview. This will help with smooth 

transitions between your audio track and your guest’s track, to make it sound more like you 

are having a natural sounding conversation with each other while sitting together in the same 

space (see Recording ‘atmos’ track for transitions in the Recording & Editing with 

Audacity section in this handbook). 

 
 

Microphone levels & sound check on Zoom 
 

 

Whether you are using an external microphone on a stand, a headset, or the internal 

microphone on your device—make sure you AND your guest are leaning in and 

speaking close to the microphone. 
 

Be aware that if people are speaking too far away from the mic it won’t sound engaging, and 

if they’re speaking too close to the mic it might sound distorted. Before you record, do a 

sound check with your guest to ensure that they know where their mic is located and that 

they are speaking close enough to their mic to get a nice, warm, close-up “radio” sound, but 

not so close that it is distorting (usually 1-2 handspan away from mic). 
 

If you and/or your guest are using the internal mics on your devices, then confirm where the 

microphone is located on both your devices. Mics are usually located on left or right 

speakers with macs, and at the top of the screen near the camera with PC’s, and where the 

charger connects on phones. You can do an online search for where the mics are located on 

your device (model) to be sure. 
 

Tell your guest not to use speaker phone if they are using Zoom on their phone∫, as 

this compromises audio quality. 

 

Lastly, you and your guest should NOT use the mute button during interview—it will put 

the separate audio files in the recording out of sync and make editing difficult later. 
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Zoom ‘Audio’ and ‘Recording’ settings on laptop: You and Guest 

 
(Note: If your guest is on mobile phone, they can follow mobile phone settings tips—next 
section.) 
 
 

1. Both you and your guest click on arrow next to microphone in bottom right 
corner and tap Audio settings: 
 

 
 

2. In Audio Settings both you and your guest: 
 

• Check ‘Show in meeting sound to “Enable Original Sound” from microphone’. 

• Enable high-fidelity music mode, echo cancellation and stereo audio 
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3. Only you—In your recording settings: 
 

• Tell zoom where to store your recordings (so you know where to find 
them later) 

• Check ‘Record a separate audio file of each participant’ 

• Check ‘Optimize for 3rd party video editor’ 

 

 
 
 
 

4. Both you and guest exit settings and return to main screen in Zoom. Then—
before you start the interview—turn Original Sound on (top left or right of 
your screen) and make sure your guest does too. 
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5. You can now press record and start the interview—the record button is at 

the bottom of your screen 

 

 
 

6. When you end the interview, you can press stop recording on the record button 
 

And then say goodbye to your guest and tap end> end meeting for all>  
 

When the Converting meeting recording window comes up WAIT for it to finish!! 
If you had a long interview this could take quite a while.  
Just leave it and let it finish.  Don't press ‘stop converting’ or you will lose your interview. 
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When the meeting ends, Zoom converts your recording and stores it either in your 
documents folder or on the cloud (specified in Zoom recording settings). 
 
Recordings will be stored in the MP4 format for video and audio, and M4A for audio-only 
files. 

 

 
^These audio.m4a recordings are now ready for you to start editing them in post-production. 

 

 

 

Zoom Guest audio settings on phone or tablet/iPad 
 

 

1. The following settings could look a bit different on different phones, but 

basically your guest will need to enter the zoom meeting from their email link, 

and then tap More (bottom right menu)   
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2. Then your guest should tap Meeting settings and check Enable Original 

Sound 

 

  
 

 
 
 
 

3. Then your guest will need to exit settings, return to main screen, and tap 

More again to Enable Original Sound 

 

 

 
 

 
 

NB: Remind your guest to also hold the phone like a microphone and speak directly into the 
main phone mics located at the base of the phone where the charger port is. Check with 
them to ensure that the speaker phone is switched OFF. 
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Importing M4a (Zoom) audio files to Audacity on Windows OS system 

 

Zoom m4a files won’t open in Audacity in Windows. You will need to convert the m4a audio 

files to wav. The easiest way to do this is using a free online m4a to wav converter app. Just 

do a browser search, there are always heaps of drag and drop options, and ensure settings 

are highest quality available. 

 

 

Importing M4a (Zoom) audio files to Audacity on Mac OS system 

 

Zoom m4a files will open directly in Audacity on a Mac OS system. You can use them in 

your editing project without making any changes. 

 

 

 

^Separate Zoom audio recordings of each participant opened in Audacity for editing 

 

 

Editing with lossy files in destructive verses non-destructive apps 
 

Some audio files, like m4a or mp3 files, contain a “lossy” audio encoding format. If you are 

using a ‘destructive’ editing app like Adobe Audition, then every time you save your editing 

project it will recompress the lossy file, compromising your audio quality. Considering that 

you will likely save your editing project multiple times while working on it, obviously this will 

be a problem. 

 

‘Destructive’ doesn’t mean that destructive editing apps are bad, it’s just a different app 

design. If you are using a destructive editing app you will just need to convert lossy audio 

files like m4a or mp3 files to a (non-lossy) wav format—or copy and paste the audio onto a 

blank wav track—before you start your editing project, to avoid compromising the audio 

quality. It only takes a few seconds to do this. To be clear, if you are using a destructive 

editing app, all the audio files in your editing project must be wav files. 

 
Alternatively, if you are using a ’non-destructive’ editing app like Audition it won’t matter, 
you can just edit with m4a or mp3 audio files, or wav files, it doesn’t matter.  
 
Be sure to check whether the editing app you are using is destructive or non-destructive 
and take precautions if needed when commencing your editing projects. 
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Location/field recording guidelines 

 

Outside recording needs careful planning as conditions differ with many variables. Prior to 

arriving to the location, ensure all preparation for the interview, the event and/or person(s) is 

finalised and ready. 

 

Recording a public speaking event 

Liaising with event organisers  

- Contact event coordinators, technicians and speakers before the day to seek 

permission to record and ensure that everyone knows who you are and why you are 

there. Ensure that you have explicit permission from event coordinators and all 

speakers to publish the recording 

- If possible, check out the venue beforehand, preferably during working hours when 

people will be around to answer any questions 

- Learn the location of power points in the space you will interview or record - it could 

save batteries and time 

- Set up equipment well in advance of the scheduled starting time and allow time for 

packing up and transport to the location 

- Consider the audience and be as unobtrusive as possible  

Recording public speaking at an event 

Equipment: 

• portable recorder 

• Headphones and microphone 

• Assortment of leads and connectors: XLR, RCA, mini & 1/4-inch jacks 

• Batteries, extra long power cables, adapters 

• Mic stand & gaffer tape 

 

- The best option for a good recording at a public speaking event is plug your portable 

recorder directly into the event’s PA system.  

- Politely ask event coordinators if they are able to provide a contact for the sound 

technicians or person organising the audio set up, so you contact them to ask if you 

can record through the PA system. Find out what cables you need to bring to connect 

to your portable recorder. If you are unable to contact the tech people before the day 

bring an assortment of leads and connectors. Arrive early to allow time to liaise with 

techs. Don’t take up too much of their time and be mindful that your recording is not 

their priority. 

-    If you are unable to connect your portable recorder to the PA via a line in, the next 

best option is to run your mic out from your portable recorder and gaffer tape your 

mic to the speaker’s mic, so that they’re speaking directly into both. 

- A last resort option is to position your mic in front of the speaker box. This can 

sometime give interesting results in regard to ambience, but you should make sure to 

avoid feedback. 
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Recording vox pops & ambience at an event 

- Grip the mic firmly and don’t change your grip during vox pop recordings 

- Correct the position of the mic to accommodate for different speaking volumes in an 

interview 

- The mic should be no further than 30cm from the mouth of the person speaking 

- Never let the talent hold the microphone 

- If it’s a windy day, ensure you have a microphone windsock to cut wind noise, also 

consider moving into a sheltered space (e.g., alcove or doorway) away from crowds 

and other loud noises 

- You might spend several minutes also recording ambient sounds such as crowds, music 

or traffic etc to create a sound rich soundscape later to weave into your story. 

 

 

 
 

Recording nature sounds  

Condenser microphones can be useful for recording ambient nature sounds, however it's 

crucial to find the right balance between capturing the subtleties of the environment and 

minimizing unwanted noise. Start by choosing an appropriate condenser microphone – a 

shotgun or stereo condenser mic works well for this purpose. Consider using windshields or 

pop filters to mitigate wind noise or plosives. Position your microphone strategically, 

ensuring it's as close to the sound source as possible without disturbing the environment. 

Record during quiet times of the day, such as early mornings or late evenings, when wildlife 

and nature are more active. Additionally, be patient and allow for long recording sessions, as 

natural sounds can be unpredictable. Always monitor your audio closely to spot and address 

any interference or distortion during recording. 

 

The following article discusses creative ways to obtain good quality nature recordings: 

‘How to avoid noise when recording nature sounds’, an interview with Thomas Rex Beverly 
https://www.creativefieldrecording.com/2018/09/05/how-to-avoid-noise-when-recording-nature-sounds-

interview-with-thomas-rex-beverly 

 

  

https://www.creativefieldrecording.com/2018/09/05/how-to-avoid-noise-when-recording-nature-sounds-interview-with-thomas-rex-beverly/
https://www.creativefieldrecording.com/2018/09/05/how-to-avoid-noise-when-recording-nature-sounds-interview-with-thomas-rex-beverly/
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Recording & Editing with Audacity 

 

 
Source: https://manual.audacityteam.org/

https://manual.audacityteam.org/
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Getting started with Audacity 

Audacity is a powerful and versatile open-source (free!) audio editing program, offering a 
wide range of features and compatibility for creating, editing, and enhancing audio 

recordings.  You can access Audacity for Windows, Mac OS & Linux here: 
https://www.audacityteam.org/download/ 
 

After you have installed Audacity, remember to regularly update it—at least 
twice a year. This is vital for accessing new features, improvements, and 
enhancing your audio editing experience. 

Setting your preferences  

 

 

 
*NB Preferences may also be listed on 
the top menu under File or Edit. 

 

You should always record and edit with high quality broadcast settings. The settings 
suggested in the following screen grabs are the minimum for this. You can set yours higher if 
you like.  

• Lowest recommended ‘high quality’ settings:  
 Channel: Mono; Sample rate: 44100Hz (44.1kHz); Bit rate: Lowest: 16-bit 

• Highest recommended ‘high quality’ settings:  
 Channel: Stereo; Sample rate: 48000Hz (48Hz) (or 24-bit); Highest: 32-bit 
 

Note: A mono channel is fine for chat-based podcasting, and a stereo channel (only 
available with 2 or more microphones) is better for sound-rich, layered audio with music or 
ambient sound.  

 
^Make sure that ‘project sample rate’ and ‘default sample rate’ are the same 

 

https://www.audacityteam.org/download/
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Change the Tracks default Waveform scale to Linear (dB) as it will be easier to monitor your 
sound levels (gain) and ensure that it is sitting between the optimum -minus 6 and -minus 
12dB for voice recording and editing. 

Setting up a project folder 

An Audacity project folder will contain all the necessary files and data related to a specific 
audio editing project. You should start a new Audacity project folder for each episode of your 
podcast and maintain an organised folder system that makes sense to you, for easy 
workflow and archiving purposes. 
 
To save a new project folder: File > Save Project > Save Project As 
(command/Ctrl+S) 
 

 
 
Place all the audio files/tracks that you will be using for your editing project (podcast 
episode) in your project folder, and save any new recordings for this project (podcast 
episode) that you do in Audacity, in the same project folder: 
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Importing audio tracks 

To import audio tracks from your project folder, you can drag and drop them into Audacity 
anywhere in the empty grey work area OR click: File > Import > Audio and select one or 
more audio files. Audacity will import the selected file(s) into the existing project. 
 
You can open as many as you want in a project and then right scroll to view them if not all 
visible. Bottom scroll to view the entire audio file if not all visible (see Navigation). 
 

 

 
 

 
 

 
Importing or drag & drop more than one audio track directly into Audacity will create a multi-
track session (see multi-tracking with music or SFX sound bed). 
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Track Control Panel 

 

Track settings: 
 
 

Sample Rate (rate): 44,100 
Resolution (format): 16bit  

 
Adjust settings on audio tracks 

• Select Audio track (black arrow 
next to file name for drop down 
menu) 

• Scroll down to Format > Choose 
16-bit PCM 

• Scroll down to Rate > Choose 
44100 Hz  

  
 
 
To make changes to a track you first need to select it by clicking anywhere on the 
soundwave display (dark blue squiggly pattern) in the track to make the Track 
Control Panel turn pale blue. 
 
 

 
Not Selected 

 
Selected 
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If you have multiple tracks open, you can mute the tracks you are not working on 
(*note Track Control Panel is blue on the top track, which is being worked on) 
 

 
 

If you import a stereo track, you can convert it to mono via dropdown Track Menu: 
Tracks > Mix > Mix Stereo Down to Mono (*note the Track Control Panel is blue) 
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Transport Toolbar: Playback and Recording 

 

While you are editing you can use the transport toolbar to playback audio and 
review any changes you have made.  
Note: you will not be able to edit while in “play” or “pause” mode) 
 

   

 

 

Note: If you are wearing headphones but the track is playing out from your speakers, 
you may need to select your headphones on the Device Toolbar 
 

 

Navigation 

You can choose various tools for editing including selection, adjusting gain/sound 
levels, moving audio around and other functions (hint: hover your mouse over each 
tool and its function appears) 

Zooming in/out tools 

Zooming in & out helps you to navigate easily between zooming out for a wide view 
of your entire project or zooming in for close-ups of sections of your audio file more 
accurate fine editing. Zoom tools are located on the drop-down View menu or on the 
Edit Toolbar. 
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Note: Easy Zoom shortcut tip: Press command/control key and scroll up/down 
with mouse/keypad 

 

 
 

 

 
 

 

Horizontal and vertical scroll bars 

 
You can also use the horizontal and vertical bars to navigate your project:   
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Recording & Playback Meter Toolbars 

Both recording and playback levels are shown on the Recording Meter Toolbar & 
Playback Volume Meter Toolbar. These tools assist you to ensure that your 
gain/sound levels are ideally sitting mostly between -12 to -6 dB.  
 

 
 
If the audio you are editing has been unfortunately recorded with the sound 
levels too low or too high, then you will need to try to repair it. The Playback 
Meter Toolbar will assist you in this task (see 7. Amplify) 
 

 

Recording Tips 

• Always record and listen with headphones on  

• Be aware of recording levels and adjust fader to ensure they are sitting 

between -6 & -12 dB for spoken word (music recording is more flexible). 

• Lean in close to the microphone before you start speaking (your mouth should 

be about 5—10cm from the microphone)  

• Be careful to avoid sounds of microphone handling, squeaky chairs and paper 

etc.  

• Don’t move the microphone while you are speaking  

• Don’t speak over the top of other presenters or guests—if you accidentally do 

this then pause and start again.  

• Record at least 30 seconds of studio “atmosphere” at the end. You will need 

to be very silent and sit away from the microphones (or even leave the studio) 

while this is recording (see Recording atmos track for transitions). 
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Recording ‘atmos’ track for transitions  

 

It can be handy to have an atmosphere (‘atmos’) track when you get to the editing/ 
postproduction phase. This is a roughly 1-minute recording of the background sound 
of the environment you are recording in (e.g., studio sound or on-location 
background/atmospheric sound). This will help with smooth transitions, when you are 
moving between sound environments – between different segments (e.g. intro to 
interview). You can fade in and out of segments using the background atmosphere 
track.  
 
An atmosphere track can sometimes also assist with reducing problematic 
continuous/monotonous noise (e.g., noisy air conditioner or traffic etc.). To apply 
noise reduction effects, you will need a clear recording sample that (ideally around 1 
minute) to use as the noise reduction filter.  

 

Editing Tools 

 

Selection Tool (Tools Toolbar) 

The main editing tool you will use is the Selection Tool, located on the Tools Toolbar: 
 

 
 

You can use the Selection Tool  to highlight a portion of audio and make a 
change. 
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Undo/Redo (Edit Toolbar) 

If you aren’t happy with a change you have made, you can “undo” it using these tools 
located on the Edit toolbar or Edit dropdown menu: 
 

 

 

 

Editing Techniques 

Delete or cut & paste 

Select desired section by left click & drag with Selection tool  

To delete you can select and then Edit > Cut or press delete button  on your 
keyboard (not  backspace) 
To reposition or rearrange small audio segments you can cut and paste: 

• Edit > Cut > Paste 
• Shortcuts: Ctrl/Command C & V 
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Splitting tracks  

Mark cue spot with select tool   
 

 
and Click Edit > Audio Clips > Split to split the track into two or more separate 
clips  
 

 
 

To move a clip around, simply drag and drop it using the Clip-handle (the light area 
with the rounded corners) at the top of the clip: Left or right, or up or down into 
another track 
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Cue points, labels & notes 

Mark and notate cue points with Selection tool and do Edit > labels> add label at 
selection.  
It will create a label track underneath the track you’re editing, which you can label, 
or use to make editing notes to yourself: 
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(Cue points & labels) 

 

Fade In/Out 

Select the section you want to fade with the Selection Tool (right click, hold down & drag) 
Select Effects menu > Scroll down to Fade in or Fade out 
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Repairing sound levels with Amplify effect 

• Select/ highlight the section of the audio that you want to remove with the 
Selection Tool 

• Select Effects menu 
• Scroll down and click Amplify option 

 

 

 
 

Type in the required volume in the Amplification (dB) field to increase or decrease 
e.g. (2 or -2) or move the toggle along the amplification line left to decrease the 
volume and right to increase the volume: 
 

 
 

• Click on Preview to to check the sound level 
• Click Apply to implement the change 
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Multi-track sessions and shaping sound beds with the Envelope Tool 

• Allows you to control a track’s volume changes smoothly over time 
• Select the Envelope Tool from the Tools Toolbar: 

 

 
 

 

To manipulate and shape music/sfx sound-beds around voice-over tracks use the 
envelope tool. Double left-click at the point where you want to shape it, and then left 
click again and hold it down and sort of “slide it around” to manipulate the shape: 
 

• Click a beginning, end, and middle point on your audio waveform 
• Click and hold on a point to increase or decrease the volume. 
• To delete unwanted points, select & drag down off the audio file (just like in 

Cool Edit) 
 

 
 
 
You create a sound bed. That fades in and out, for segments in your podcast, like this 
intro below: 

 

 

 

 

  



3CR Community Radio - Podcasting Handbook, 2024   page 64 of 70 

 

 

Fiddly audio repairs 

 

Audible (bad) edits  

Are noticeable cuts that sound unnatural, e.g., a shift in the background sound 
between two clips, or words cut together too tightly.  To avoid audible edits, use care 
with each edit you make. When you’ve finished putting a piece together, listen to the 
entire thing with your eyes closed. Focus on all the sounds, noting every time you 
hear an unnatural change. Make changes as necessary. 

 

Abrupt tone-of-voice or cadence changes  

Editing can cause the tone or cadence of recorded speech to change unnaturally, 
e.g., the conversational tone during an interview might change from relaxed to 
punctuated.  They often happen as a result of editing for editorial content and 
ignoring the sound of the audio.  To avoid this, when you’ve finished putting a piece 
together, listen to the entire work with your eyes closed. Focus on the dialogue and 
listen for those moments of cadence or tone change. For unavoidable changes, 
adding a little space can help ‘reset’ our ears in time for the change. You can create 
space with a short pause or music.  

 

Upcut, missing or doubled breaths  

An upcut breath is one that is edited so it’s incomplete (or ‘chopped’) — only the first 
or last part is audible, and they sound unnatural. Doubled breaths are usually found 
when copying and pasting audio together and you end up with two breaths side-by-
side.  To avoid this, when editing breaths, listen closely to the beginning and end. If 
replacing a breath, choose one that matches the cadence and tone of the words 
around it.  

 

Clipped “s,” “f,” “h”  

The beginnings of the consonants “f” and “h” are easy to clip, as are the ends of 
words ending with the consonant “s.” “F” and “h” each have soft beginnings to the 
consonant. When editing with your eyes and not your ears, it’s easy to chop off parts 
of words starting with “f” and “h” or ending with “s.”  To avoid clipped consonants is 
to have an awareness of how easy it is to do and listen carefully. When you need to 
edit an “f,” “h,” or “s” sound, make sure you have grabbed the entire consonant.   

 

“P” pops  

Often ‘p’ sounds may distort and pop or click. When this happens the offending 
section in the audio will be very extended in a ‘V’ shape in comparison to the 
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surrounding wav form shape on either side of it. Experiment with gently selecting and 
cutting tiny parts of the most extended sections of the ‘V’ shape, while being carefully 
not to compromise the integrity of the “p”. Use the “undo” button if you accidentally 
cut too much away. 
 
 

   
“P” pop repair: delete selected section 

 

Overlap  

Occurs when two or more people speak over each other. It also happens when a 
background sound interrupts the person speaking.  
 
Before the interview remind you guest to try to remember to wait until you have 
finished speaking, pause for a moment and then answer. ou may need to use a few 
friendly reminders for those guests who tend to talk over others. 
 
If you or your guest accidentally speak over each other, pause the interview, and 
repeat what was said. Try to keep it in the flow and cadence of the original comment 
so that it will be easier to edit the repeat in smoothly. 
 
When interviewing multiple guests, direct your questions to a specific guest and 
speak their name, while maintaining focus on that individual.  

 

 

 

 

 

 

 

 

(source: https://training.npr.org/2017/01/31/the-ear-training-guide-for-audio-

producers/#editing) 

 

  

https://training.npr.org/2017/01/31/the-ear-training-guide-for-audio-producers/#editing
https://training.npr.org/2017/01/31/the-ear-training-guide-for-audio-producers/#editing
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Saving and Exporting Files 

 
To save incomplete editing projects that you are still working on: 
 

• The first time: File > Save As (saves as an .aup file) 

• Resaving:  File > Save: You should save your project regularly. All the 
individual tracks will be saved with it including new ones that have been 
created/recorded in the ongoing project. 

• Keep all the files, tracks and your .aup project file in the same folder together. 
 

When you have finished editing your project, you will need to export your podcast 
from Audacity.  

Exporting your podcast for publishing online: mp3 audio file  

1. Save your Audacity project 
 

2. File > Export > Name file and choose location > select preferred channel mode, 
sample rate, and bit rate, and Quality (min. 64kbps) 

 

 
 

3. You can experiment with export settings to find a combination you are happy with. 

 

 

 

 

 

 
4. When you are happy with your settings click Export. Your mp3 podcast episode 

is now ready to publish! 
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Exporting your podcast as a high-quality wav for radio broadcast & 

archiving  

 
1. File > Export > Name file and choose location > select preferred channel 

mode, sample rate, and bit rate. 
 

2. When you are happy with your settings click Export and save it to your 
archiving system. 
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Ethics of spoken word editing 

The ethical considerations of editing speech are important. When you are crafting the dialogue 
flow and sound to make it clearer, more attractive, or entertaining, always remember that what 
you are editing is someone else's verbalised thoughts and opinions.  

 

 (Source adapted: Radio Adelaide Training Manual, 12th edition 2009) 

MAINTAIN 
INTEGRITY 
 
 

The real art in editing talk lies in maintaining the natural rhythm and 
melody of the voice. If you take words out, ensure not to upset the flow of 
the voice. Breathing and the occasional ‘um’ are part of natural speech. 

Listen critically to the rise and fall of the voice. Listen carefully, not only to 
the words themselves and the meaning intended, but also to the rhythm, 
pitch and pace of the delivery. Leave the natural pauses in between 
thoughts. 

 

ADVISE YOUR 
TALENT FIRST 
 
 

Inform your talent of the plans for the finished product so that they are 
aware of how to frame their answers, this gives the person the opportunity 
to self edit. Most people will give a different answer if told that only five 
minutes is required rather than if told that 20 minutes is available.  

If a public speech is recorded for use in an edited form, the speaker should 
be consulted on the effects that editing will have. They should be satisfied 
that the original intention is maintained. The listener must also be aware 
that they are hearing an edited version. 

 

CLEANING 
IT UP 
 
 

Be careful not to lose vital pauses that the speaker has used for effect or 
emphasis. Pauses, if they are too ponderous for podcasting, should be 
shortened rather than edited out, whilst preserving the original nature of 
the talk. 

 

OPINION & 
FACT 
 

Leave intact the opinion of an interviewee; it would be counter-productive 
to include a key statement but to omit an essential qualification due to lack 
of time. Rather, edit out some of the facts and include them more concisely 
in the introductory material.   

CUTTING 
QUESTIONS 
 
 

You could remove all or some of your questions and to let the interviewee 
continue, providing it still makes sense. Often, it’s better to edit out the 
first question and include the information in your introductory 
announcement.   

 

USING OLD or 
ARCHIVAL 
MATERIAL 
 

Don't assume that an opinion held by someone 10 years ago will still hold 
today. If you are using archival material, contact the speaker if possible 
and check their current opinion. Also make sure you give an indication in 
your podcast of the date of the material.   
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Sourcing Music & Sound Effects 

Copyright Music Licensing 
 

However, you publish your podcast online in Australia (website and/or apps), you are subject 

to broadcasting laws—including copyright. In Australia you need two different licenses to 

use copyright music in your podcast:  
 

APRA license for artists https://www.apraamcos.com.au/music-licences  
 

PPCA license for producers https://www.ppca.com.au/music-licensing 
 

These licenses are really expensive with ongoing fees, so many people use copyright-free 

music instead. There are websites that have open-source music you can legally use on your 

podcast - usually referred to as royalty free, stock, or library music. There are also varying 

levels of creative commons licenses. 

*Also read: Media Law: Copyright and Fair Dealing: 5. When do I need a Creative Commons licence 

for my own work (and what kind should I use)? —in this handbook 

 

• You can download copyright-free music from freemusicarchive.org (usually licensed 

under Creative Commons)  

• Or record / use your own original DIY music recordings  

• Or record /use someone else’s original music DIY (i.e., no producer) recordings with 

their written permission 

 

Sound effects 
 

You can find sound effects (SFX) on commercial or copyright free SFX sites: e.g., 

freesound.org  

 

You can record you own SFX using a portable recorder or device. (Fun!)  

https://www.apraamcos.com.au/music-licences
https://www.ppca.com.au/music-licensing
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Resources & links 

 

 

Transom www.transom.org 

 

● Equipment 

● Software 

● Post-production 

● Scripting 

● Research skills 

● Advice 

● Listening examples 

National Public 

Radio (NPR)  

www.training.npr.org 

 

● Scripting 

● Research skills 

● Advice 

● Listening examples 

Audiocraft www.audiocraft.com.au 

 

● Equipment 

● Software 

● Post-production 

● Advice 

● Promotion 

 

See also 

● Community Media Training Organisation (CMTO)  cmto.org.au 

● BBC Academy  bbc.co.uk/academy 

● The Podcast Host  thepodcasthost.com 

 

Using free audio 

● Free Sound.org  freesound.org 

● Free Music Archive  freemusicarchive.org 

● Creative Commons Search  creativecommons.org 

 
 

 

 

 

 

 

 

 

http://www.transom.org/
http://www.training.npr.org/
https://www.audiocraft.com.au/
http://www.cmto.org.au/
http://www.bbc.co.uk/academy
https://www.thepodcasthost.com/
http://www.freesound.org/
http://www.freemusicarchive.org/
https://creativecommons.org/
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